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Caution  
US Federal law restricts this device to sale by or on the 
order of a physician. 

 
 

Copyright 
© Copyright 2019, Welch Allyn. All rights are reserved. To support the intended use of the 
product described in this publication, the purchaser of the product is permitted to copy this 
publication, for internal distribution only, from the media provided by Welch Allyn. No other use, 
reproduction, or distribution of this publication, or any part of it, is permitted without written 
permission from Welch Allyn. Welch Allyn assumes no responsibility for any injury to anyone, or 
for any illegal or improper use of the product, that may result from failure to use this product in 
accordance with the instructions, cautions, warnings, or statement of intended use published in 
this manual.  Unauthorized copying of this publication may not only infringe copyright but also 
reduce the ability of Welch Allyn to provide accurate and up-to-date information to users and 
operators alike. 
 
Welch Allyn®, CardioPerfect® Workstation and SpiroPerfect® are registered trademarks of Welch 
Allyn.  
 
Software in this product is Copyright 2019, Welch Allyn. All rights are reserved. The software is 
protected by United States of America copyright laws and international treaty provisions 
applicable worldwide.  Under such laws, the licensee is entitled to use the copy of the software 
provided on the original distribution medium. The software may not be copied, decompiled, 
reverse-engineered, disassembled or otherwise reduced to human-perceivable form. This is not 
a sale of the software or any copy of the software; all right, title and ownership of the software 
remains with Welch Allyn.  
 
The information contained in this manual is subject to change without notice.  
All changes will be in compliance with regulations governing manufacture of medical equipment.  
 

User responsibility 
This product is designed to perform in conformity with the description thereof contained in this 
manual and accompanying labels and inserts, when assembled, operated, maintained and 
repaired in accordance with the instructions provided. A defective product should not be used. 
Parts that are broken, plainly worn, missing or incomplete, distorted or contaminated should be 
replaced immediately. Should any repair or replacement become necessary, we recommend that 
service be performed at the nearest approved service center. The user of the product shall have 
the sole responsibility for any malfunction, which results from improper use, faulty maintenance, 
improper repair, damage or alteration by anyone other than Welch Allyn or their authorized 
service personnel. 
 

Accessories 
The Welch Allyn warranty can only be honored if you use Welch Allyn approved accessories and 
replacement parts. 
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Caution  Use of accessories other than those recommended by Welch Allyn may 

compromise product performance. 

Warranty, Service, and Spare Parts 
Warranty 
All repairs on products under warranty must be performed or approved by Welch Allyn. 
Unauthorized repairs will void the warranty. In addition, whether or not covered under warranty, 
any product repair shall exclusively be performed by Welch Allyn certified service personnel. 
 
Assistance and Parts 
If the product fails to function properly or if assistance, service, or spare parts are required, 
contact the nearest Welch Allyn Technical Support Center.  
 
Before contacting Welch Allyn it is helpful to attempt to duplicate the problem and to check all 
accessories to ensure that they are not the cause of the problem. 
 
When calling, please be prepared to provide: 
• Product name and model number and complete description of the problem 
• The serial number of your product (if applicable) 
• The complete name, address and phone number of your facility 
• For out-of-warranty repairs or spare parts orders, a purchase order (or credit card) number   
• For parts order, the required spare or replacement part number(s) 
 
Repairs 
If your product requires warranty, extended warranty, or non-warranty repair service, please call 
first the nearest Welch Allyn Technical Support Center. A representative will assist you 
troubleshooting the problem and will make every effort to solve it over the phone, avoiding 
potential unnecessary return.  
 
In case the return cannot be avoided, the representative will record all necessary information and 
will provide a Return Material Authorization (RMA) number, as well as the appropriate return 
address. A Return Material Authorization (RMA) number must be obtained prior to any return. 
 

 Note Welch Allyn does not accept returned products without an RMA. 
 
Packing Instructions 
If you have to return goods for service, follow these recommended packing instructions: 
• Remove all hoses, cables, sensors, power cords, and ancillary products (as appropriate) 

before packing, unless you suspect they are associated with the problem. 
• Wherever possible use the original shipping carton and packing materials. 
• Include a packing list and the Welch Allyn Return Material Authorization (RMA) number. 
 
It is recommended that all returned goods be insured. Claims for loss or damage to the product 
must be initiated by the sender. 
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Limited Warranty Statement 
Welch Allyn, Inc. warrants that the Welch Allyn CardioPerfect Workstation computer-based 
product you have purchased meets the labeled specifications of the Product and will be free from 
defects in materials and workmanship that occur within 1 year after the date of purchase. 
Accessories used with the Product are warranted for 90 days after the date of purchase.  
 
The date of purchase is: 1) the date specified in our records, if you purchased the Product directly 
from us, 2) the date specified in the warranty registration card that we ask you to send to us, or 3) 
if you don’t return the warranty registration card, 120 days after the date on which the Product 
was sold to the dealer from whom you bought the Product, as documented in our records. 
 
This warranty does not cover damage caused by: 1) handling during shipping, 2) use or 
maintenance contrary to labeled instructions, 3) alteration or repair by anyone not authorized by 
Welch Allyn, and 4) accidents. 
 
You assume all responsibility for use of the Product with any hardware or software that does not 
meet the system requirements described in the Product documentation. 
 
If a Product or accessory covered by this warranty is determined to be defective because of 
defective materials, components, or workmanship, and the warranty claim is made within the 
warranty period described above, Welch Allyn will, at its discretion, repair or replace the defective 
Product or accessory free of charge. 
 
You must obtain a return authorization from Welch Allyn to return your Product before you send it 
to Welch Allyn’s designated service center for repair.  
 
THIS WARRANTY IS IN LIEU OF ALL OTHER WARRANTIES, EXPRESS OR IMPLIED, 
INCLUDING BUT NOT LIMITED TO THE IMPLIED WARRANTIES OF MERCHANTABILITY 
AND FITNESS FOR A PARTICULAR PURPOSE. WELCH ALLYN'S OBLIGATION UNDER 
THIS WARRANTY IS LIMITED TO REPAIR OR REPLACEMENT OF PRODUCTS 
CONTAINING A DEFECT. WELCH ALLYN IS NOT RESPONSIBLE FOR ANY INDIRECT OR 
CONSEQUENTIAL DAMAGES RESULTING FROM A PRODUCT DEFECT COVERED BY THE 
WARRANTY. 
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WARNING 
Power strips (multiple portable socket outlets) are not allowed for 
use in connecting the medical electrical equipment or any 
accessories to ground unless used in concert with a medical 
approved isolation transformer. 

During defibrillation, the ECG signals displayed may show waveform 
artifacts and cannot be relied on as a true indication of the patient’s 
physical condition. 

Accessible metal parts, such as electrode terminations, should not 
come in contact with other electrically conductive parts, including 
earth ground. 

Welch Allyn provides a number of high quality patient leads in 
varying termination styles.  Use of these approved patient leads is 
required for electrical protection of the patient during cardiac 
defibrillation. 

CardioPerfect devices are not intended for direct cardiac application. 

An inoperable or damaged electrocardiograph can be identified by 
abnormal signals on the ECG waveforms.  Abnormal signals are 
characterized by flat lines, excess noise, square waves or other non 
typical anomalies that appear on the ECG waveform.  The 
electrocardiograph can be periodically tested by connecting the 
CardioPerfect to an ECG simulator.  Follow manufacturer’s 
instructions. 

If there is a requirement for equipment to be connected to a personal 
computer or other non-medical rated equipment, it is the 
responsibility of the user to ensure that the electric power circuit to 
which the CardioPerfect system is connected includes an additional 
protective earth ground or an isolation transformer in order to satisfy 
the IEC 60601-1 safety standard. 

Other medical equipment—including but not limited to defibrillators, 
ultrasound machines, pacemakers, and other stimulators—may be 
used simultaneously with the electrocardiograph. However, such 
devices may disturb the electrocardiograph signal. 

The electrocardiograph has not been designed for use with high 
frequency (HF) surgical equipment and does not protect against 
hazards to the patient.    

Fire and explosion hazard. Do not operate the electrocardiograph in 
the presence of a flammable anesthetic mixture with air, oxygen, or 
nitrous oxide; in oxygen-enriched environments; or in any other 
potentially explosive environment. 

To prevent the spread of infection, take these precautions: 

• Dispose of single-use components (for example, electrodes) 
after using them once. 

• Regularly clean all components that come in contact with 
patients. 

• Consult your facility's equipment cleaning procedures when 
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performing ECG testing on patients with open, infectious 
sores. 

Ensure the location of the electrode and associated cables provides 
maximum separation away from all sources of high-frequency 
energy. The best way to ensure patient safety is to completely 
remove all electrodes and cables from the patient when exposed to 
high-frequency energy. 

No modification of this equipment is allowed. 
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Welcome  
Welcome to Welch Allyn CardioPerfect Resting ECG, a module of Welch Allyn CardioPerfect 
Workstation.  
With the Welch Allyn CardioPerfect Resting ECG Module, you can record, view and interpret 
resting ECGs. You can also use it to print ECGs in various formats. 
 
This manual contains specific information about the Resting ECG Module of Welch Allyn 
CardioPerfect Workstation. For all general information about the workstation software please 
refer to the Workstation manual, this includes:  

- Creating and editing Patient cards 
- General information about printing 

 
For information about the ECG hardware and accessories please refer to the Pro Manual. 
For further information on installation and configuration please refer to the Installation manual. 
Detailed information on servicing is described in the Service and Advanced Installation manual. 
 

Intended use 
Using the optional ECG module and associated accessories, the user can acquire, view, store, 
and print ECG waveforms. The ECG module also provides optional algorithms (MEANS) to 
generate measurements, data presentations, graphical presentations, and interpretive 
statements on an advisory basis. These are presented for review and interpretation by the 
clinician. 
 

Indications  
Indications for electrocardiography range from routine screening of cardiac health in the 
physician office environment to directed diagnostic differentiation in a hospital cardiology 
department.  
 

Contraindications 
There are no known contraindications for the recording of a resting ECG. 
 

 
Caution  A computer generated interpretation cannot replace sound medical reasoning 

by a trained professional. Therefore, a physician should always review the 
interpretation. 
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1. Getting started 

1.1. The Welch Allyn CardioPerfect resting ECG window 
This section will guide you around the various parts of Welch Allyn CardioPerfect Resting ECG 
module.  
 
 
 

  
 

 

Menu bar Title bar Toolbar Search 
area 

Status bar 
 

Parameters 
area 
 

Interpretation 
area 

Workspace 
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Title bar The title bar displays the name of the program. The title bar contains three buttons 
that you can use to maximize, minimize and close the Workstation window. 

Menu bar Each menu in the menu bar contains a number of tasks that you can perform with 
Welch Allyn CardioPerfect. Sometimes, menus are gray. This means that you 
cannot access that functionality at that particular point, either because it is not 
available, or because you are not authorized to use it. Each module has its own 
menu bar. 

Tool bar The tool bar contains buttons that give you easy access to the most common tasks 
in Welch Allyn CardioPerfect. 

Search area The search area contains search and display functionality that lets you easily 
retrieve patients and tests. In the search area, you can find a patient, see which 
tests were recorded for that patient and see the kind of tests that were recorded. 
You can also create search patterns, an easy way of finding information that you 
need frequently. 

 

Workspace The workspace is the core part of Welch Allyn CardioPerfect. It displays the ECG 
in various formats. These formats, also called views, are each displayed on a 
separate tab. The workspace is the place where you view, compare and measure 
ECGs. 

Parameters 
area 

 

The parameters area contains some details of the ECG, such as the age and the 
heart rate of the patient, and the global measurements for the ECG (P duration, 
QRS duration, PQ duration, QT duration, corrected QT duration, P-axis, 
QRS-axis, T-axis and QTd or JTd duration). 

Interpretation 
area 

 

The Interpretation area contains the interpretation (either entered by the physician 
or generated by MEANS software). It displays the interpretation text and whether 
the interpretation has been confirmed. 

Shortcut 
menu 

In the workspace, you can use shortcut menus to access the most common tasks. 
You can access these by clicking on the workspace with your right mouse button. 

Status bar The status bar displays the name of the user that is currently logged on to Welch 
Allyn CardioPerfect. 
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2. Recording ECGs 

2.1. Record an ECG 
Welch Allyn CardioPerfect records ECGs quickly, easily and reliably. All you have to do is make 
sure the electrodes are placed correctly and switch on the AM12. Welch Allyn CardioPerfect 
takes care of recording, making a number of measurements and calculations, saving the 
recording, and providing a first interpretation. 
 
To record an ECG, you need to follow these global steps. Each step is explained in more detail 
on the following pages. 

1. Place electrodes on the patient. 
2. Select or create a patient. 
3. Create a new ECG. The Real-time monitor is displayed.  
4. The Recorder will be switched on automatically. The Real-time monitor displays the ECG 

traces. 
5. Select how you want to see leads and set a rhythm strip. 
6. If necessary, apply an AC filter to remove possible noise that is due to AC mains 

interference. 
7. In the Real-time monitor, wait until the signal is stabilized and click the Record button to 

start recording. The progress of the recording is shown in the gauge at the bottom of the 
window. 

8. The Recorder will be switched off automatically. Welch Allyn CardioPerfect automatically 
saves the ECG and calculates the averaged complexes.  

9. Disconnect the patient. The recorded ECG is automatically displayed. 
 

2.2. Place electrodes on the patient 
Important:  Because Welch Allyn CardioPerfect is a 12 lead electrocardiograph all electrodes 
must be connected! Proper skin preparation (abrasion if necessary) and proper electrodes are 
very important for a good signal quality. 
 
Important: When you connect the electrodes to the patient, make sure that the electrodes and 
their connectors (also the RL/N electrode) do not contact other conducting parts (including earth). 
 
Extremity electrodes 
The electrodes may be placed on any part of the arms or the legs as long as they are below the 
shoulders in the former and below the inguinal fold anteriorly and the gluteal fold posteriorly in the 
latter. Any other placement necessary by deformed or missing extremities must be noted on the 
record. 
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Precordial electrodes 
Connect the precordial electrodes in the following positions: 
 

AHA IEC 

  

V1 Fourth intercostal space at the right border of the sternum. C1 
V2 Fourth intercostal space at the left border of the sternum. C2 
V3 Midway between locations V2 and V4. C3 
V4 At the mid-clavicular line in the fifth intercostal space. C4 
V5 At the anterior axillary line on the same horizontal level as V4. C5 
V6 At the midaxillary line on the same horizontal level as V4 and V5. C6 
RA Right arm R 
LA Left arm L 
RL Right leg N 
LL Left leg F 

 

Reusable Electrodes 
Each electrode must be attached securely. The electrode paste, gel, or cream must cover an 
area the size of the electrode, but must not extend beyond it, especially on the chest. 

LL 

V1 V2 
  V3 
   V4    V5    V6 

RA LA 

RL  N  F 

C1 C2 
  C3 
   C4    C5    C6 

R                     L                
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Disposable Tab Electrodes 
Disposable electrodes have conductive material on the adhesive side only. 
The electrode tab must be placed between (clip) or on (banana or pushbutton) the electrode 
adapter, and it must remain flat. Do not attempt to place the electrode adapter so close to the 
circular part of the electrode that the tab of the electrode is bent, or contact is made with the 
conductive gel. Gently tug on the electrode adapter to ensure that the electrode adapter is 
properly placed on the electrode. Good and accurate placement of each electrode on the first 
attempt is important. Each time an electrode is lifted off the skin and reattached, the adhesive gel 
becomes less effective. 
 
 

Caution  
Never mix reusable and disposable electrodes on the same patient. 

 

2.3. Create a new ECG  
To create a new test: 

1. Select the patient. See the CPWS Workstation manual for details. 

2. In the File menu, point to New and click ECG. The New ECG dialog box is displayed. 

 
3. In the New ECG dialog box, select the Name and the Specialty of the Referring physician 

and/or the name of the Ordering physician, and select the lead set that you want to use for 
the ECG. 

4. Click the OK button. The Real-time monitor is displayed. Here you can adjust your view 
settings and start recording the test. 
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5. The Real-time monitor displays the ECG traces. 

 

2.4. Select how you want to view leads 
Once you have created a new ECG, the Real-time monitor displays the ECG traces. Before you 
start the actual recording, you can select how you want to view the traces. Welch Allyn 
CardioPerfect offers three different views: 1x12, 2x6 and 4x3. In addition, you can set different 
chart speeds and different sensitivities. 
 
To select a different view: 

• In the Real-time monitor, select a view from the list. The new view is immediately 
displayed. 

 
To select a different chart speed or sensitivity for the view: 

• In the Real-time monitor, select a chart speed or sensitivity from the list. The speed and 
sensitivity are immediately displayed. 

 

2.5. Set a rhythm strip 
As a default, Welch Allyn CardioPerfect uses lead II as a rhythm strip, but you can set any lead as 
a rhythm strip. 
 
To set another lead as a rhythm strip: 

• In the Rhythm strip pane, select a lead from the list. The new lead is immediately used as 
a rhythm strip. 

 
To set the speed and the sensitivity of the rhythm strip: 

• In the Rhythm strip pane, select a speed and sensitivity. The new speed and sensitivity 
are immediately used. 

 

2.6. Turn pacemaker on and off 
ECG traces can contain artificial pacemaker signal indicators. You can remove this artificial pacer 
indicator by disabling the "Show Pacer" selection. To learn how, see Customizing the Resting 
ECG software on 40. 

2.7. Apply an AC filter 
ECG traces can contain noise that is due to AC mains interference. This makes the traces harder 
to read. You can filter out noise by applying an AC filter. When you apply a filter, the original ECG 
signal is not permanently changed. You only change the way it is displayed on the monitor. You 
can always restore the original signal. 
 
To apply an AC filter:  

• At the top of the Real-time monitor, click AC filter. Click again to switch the filter off. 
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2.8. Apply a muscle noise filter 
Muscle noise in an ECG signal hides low amplitude signals that may be important for the 
interpretation of an ECG. You can remove this noise with a muscle noise filter.  
To apply a muscle noise filter:  

• At the top of the Real-time monitor, click Muscle filter. Click again to switch the filter off. 
 

2.9. Record an ECG 
You are now ready to record the ECG.  
 
To record an ECG: 

1. In the Real-time monitor wait until the signal is stabilized and click the Record button to 
start recording. The progress of the recording is shown in the gauge at the bottom of the 
window. 

2. Next see §2.1 and follow steps 8-9. 
 

Create a pretriggered recording 
When you want to catch a particular event, such as arrhythmia, without having to record an entire 
ECG, you can use a pretriggered recording. When you start a pretriggered recording, it includes 
the five seconds before and after you clicked on the Record button. This means that when you 
see an event and click the Record button, your recording includes the event, five seconds before 
the event, and five seconds after the event. 
 
The pretriggered option is also convenient when you have difficulties recording an ECG with 
clean traces, for example because the patient has muscle spasms. The pretrigger option helps 
define the 10 seconds of recording by already saving 5 seconds of possibly clean traces. 
 
To create a pretriggered recording: 

1. Create a new test. The Real-time monitor is displayed. 
2. In the Real-time monitor, click the Pretrigger option. 
3. Wait until you see the event that you want to record. 
4. As soon as you see the event, click the Record button. Welch Allyn CardioPerfect will 

continue recording for five more seconds. 
5. Next see §2.1 and follow steps 8-9. 
6. The recorded ECG is automatically displayed, including the event that you wanted to 

capture. 
 

2.10. Recording rhythm ECGs 
The procedures for recording a rhythm ECG are almost identical to those for recording a regular 
ECG. If you need any detailed help with the steps that follow, please refer to section 2.1. 
To record a rhythm ECG: 

1. In the Real-time monitor wait until the signal is stabilized and click the Rhythm button to 
start recording. The progress of the recording is shown in the gauge at the bottom of the 
window. 

2. Next see §2.1 and follow steps 8-9. 
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Capture an event 
When you notice an event, like arrhythmia, during recording, you can capture this in the ECG. 
When you do this, a small exclamation mark is inserted at the place where the event occurred. 
 

• To capture an event, click the Event button. 
 

2.11. Cancel a recording 
You can cancel a recording at any time in the recording process. 
To cancel a recording: 

• Click the Cancel button in the Real-time monitor. The recording is cancelled r. The test 
is not saved. 

Tips for canceling a recording: 
• When you have not yet recorded 10 seconds of regular ECG, you can also cancel the 

recording by clicking the Record button. 
• You can choose to record a regular ECG or a rhythm ECG without leaving the real-time 

monitor. 
 

2.12. Pacemaker pulse detection 
The Welch Allyn CardioPerfect software is able to display pacemaker pulse spikes detected by 
the hardware. These spikes are marked with a symbol in the Real time monitor, in Review mode 
and on printouts.  
 
When the Pacemaker pulse detection is on, the detected spikes are marked on the trace, as 
shown here. To learn how to disable this function to remove artificial pacemaker signal indicators, 
see Customizing the Resting ECG software on 40. 
 

 
Pacemaker markers 
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2.13. Signal quality indication 
 
If Welch Allyn CardioPerfect Workstation finds the signal from one of the channels to be 
erroneous, for example caused by a disconnected electrode, the monitor will display “Bad signal 
on…”.  The trace shows square waves, see example below. 
 
 

 
 
Please check the indicated electrodes/channels immediately! 
 
The status information is saved with the test. Erroneous leads will show square waves on both 
the Review and the printout. Depending on the duration of the erroneous signal no interpretation 
or measurement will be possible and therefore will not be shown. 
 
In the few moments between the lead disconnection and when the software detects the 
disconnection, pacemaker spikes may be erroneously detected. As a result, a group of 
pacemaker markers may be shown on the trace just before the square waves are shown. The 
pacemaker pulse detection will be suppressed as soon as the square waves are shown and will 
continue to be suppressed until the erroneous signal is corrected. 
 
Leadoff, Framing Errors and DCOffset conditions: 
 
If the application detects a Lead-off or other error within 10 seconds after you have started an 
ECG recording, the recording automatically restarts. In the case of a Leadoff condition, the ECG 
recording will not start until the signal is stabilized. The progress bar of the recording will remain 
at 0 until all the signals are of acceptable quality. 
 
You can use the override button to disable the automatic restart. 
 
 
Leadoff  The Leadoff message displays in the workspace when an electrode is  
  disconnected. The real-time monitor will display “Bad signal on…”.  The trace 
  shows square waves until the signal is stabilized. 

Square waves 
 

Warning in red 
 

Override 
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3.  Recording ECGs for pediatric patients 

Pediatric Electrode Placement 
CardioPerfect supports two lead sets for the recording and interpretation of pediatric 
electrocardiograms. Where anatomically feasible, the standard electrode placement described 
on page 12 may be used. For very small children, an alternative arrangement is described below, 
in which leads V3R and V7 replace V3 and V5.  

Extremity electrodes 

The electrodes may be placed on any part of the arms or the legs as long as they are below the 
shoulders in the former and below the inguinal fold anteriorly and the gluteal fold posteriorly in the 
latter. Any other placement necessary by deformed or missing extremities must be noted on the 
record. 
 
Pediatric Precordial electrodes 
Place the electrodes on the anatomical positions V3R, V1, V2, V4, V6 and V7, then attach 
precordial lead wires 1 through 6 from left to right. 
 
Connect the precordial electrodes in the following positions: 
 

AHA IEC 
V1 Fourth intercostal space at the right border of the sternum (V3R). C1 
V2 Fourth intercostal space, at the right sternal margin (V1). C2 
V3 Fourth intercostal space, at the left sternal margin (V2). C3 
V4 Fifth intercostal space, on the left mid-clavicular line (V4). C4 
V5 Left midaxillary line, at the horizontal level of V4 (V6). C5 
V6 Left posterior axillary line, at the horizontal level of V4 (V7). C6 
RA Right arm R 
LA Left arm L 
RL Right leg N 
LL Left leg F 

 
 
 
 
 
To select the pediatric lead set: 

1. Place electrodes on the patient. 

2. In Welch Allyn CardioPerfect, select or create a patient. 
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3. In the File menu, point to New and click ECG. The New ECG dialog box is displayed. 

 

4. From the Lead set list, select Pediatric and click OK. 

5. Follow the steps on page 14 to finish recording the ECG. 

 
 



 
CardioPerfect Workstation 

Resting ECG Module - User Manual 
 

DIR 80012333 Ver. G   21 / 56 
 

4. Viewing ECGs 
To view an ECG: 

1. Select a patient. The tests that have been recorded for that patient are listed in the test 
list 

 

 
2. From the test list, click the ECG that you want to see. ECGs are indicated with a  sign. 

Welch Allyn CardioPerfect is started automatically, and the test is displayed in the 
workspace. 

 

 
 
 
 

4.1. View and edit ECG information 
The Information window gives you all kinds of information about the ECG that you are currently 
viewing. You can see the name of the referring physician, the name of the technician that 
recorded the ECG and any comments that were entered. If you wish, you can add some 
comments. 
 
To view ECG information: 

• In the Tools menu, click Information. The Information window is displayed. 

Patient list 

Test list 

View 

Parameters Interpretation 
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To add your comments: 

1. Type your comments in the Information window. 
2. Click OK to save your comments. 

 

4.2. Views 
Welch Allyn CardioPerfect offers various views on an ECG. Each view highlights a different 
aspect of the ECG. Each view is presented on a different tab in the workspace and has different 
functionality.  
 
You can view at all twelve leads in two different formats (the traditional 4x3 format, and a 
convenient 2x6 format). You can also view the measurements that Welch Allyn CardioPerfect 
calculated, or display one single average complex. If you recorded a rhythm ECG, you can 
examine the entire recording.  
 
 

 
 

 
4x3 view 
The 4x3 view displays a 12 lead-ECG strip of 
2.5 seconds long. The leads are shown in a 4x3 
configuration with a rhythm strip at the bottom 
of the view.  
View can be simultaneous or sequential. 
 
 
 

 

  
 

 
2x6 view 
The 2x6 view displays a 12 lead-ECG strip of 5 
seconds long. The leads are shown in a 2x6 
configuration. On the left, leads I through aVF 
are displayed; on the right, leads V1 till V6 are 
displayed. 
View can be simultaneous or sequential. 
 

 

 
 

 
Averages view 
The Averages view displays the averages of 
the dominant complexes for all 12 leads. You 
can also view a single average complex, 
display markers and compare complexes of 
other ECGs. 
 
 
 

file://skfnas01/../../CPWS%20Resting%201.6.1/Enlarge_a_complex_or_loop.htm
file://skfnas01/../../CPWS%20Resting%201.6.1/Display_markers.htm
file://skfnas01/../../CPWS%20Resting%201.6.1/Compare_ECGs.htm
file://skfnas01/../../CPWS%20Resting%201.6.1/Compare_ECGs.htm
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Measurements view 
The Measurements view displays the 
measurements that were taken by the 
computer. These measurements include the 
values for several common parameters, such 
as Q, R and S amplitude and ST values. The 
amplitudes are expressed in microvolts. The 
durations are expressed in milliseconds. 
The measurements cannot be edited. 

 

 

 
Rhythm view 
When you have recorded a rhythm ECG, you 
can view the entire ECG in the Rhythm view. 
You can use the scroll bar to move through the 
ECG.  
 
The Rhythm view displays leads in different 
groupings, so that you can easily switch 
between the most common groups.  
 

 

 
 

 
Old rhythm strip 
The Old rhythm strip view is only available for 
ECGs that were recorded with older versions of 
the Workstation software (software from before 
2000). It displays the original II V2 rhythm strip. 
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Vector view (optional) 
The Vector view is only available if the 
vectorcardiogram option is enabled. It displays 
the results of an ECG in a vectorcardiogram.  
 
The left hand pane displays the reconstructed 
orthogonal x, y and z leads. The right hand side 
of the Vector view is divided into three windows. 
Window 1 displays the following loops: 

• F: complete frontal loop 
• H: complete horizontal loop 
• R: complete right sagittal loop 

Window 2 displays the following loops: 
• Ft: frontal plane of the T wave 
• Ht: horizontal plane of the T wave 
• Rt: right sagittal plane of the T wave 

Window 3 displays the following loops: 
• Fp: frontal plane of the P wave 
• Hp: Horizontal plane of the P wave 
• Rp: Right sagittal plane of the P wave 

 

 

 

 
R-R view (optional) 
R-R is the interval between two subsequent 
QRS complexes. The R-R view gives an 
overview of the heart rate variability. This view 
lists the number of intervals, the minimum, 
maximum and average number, and the 
standard deviation. 
 

• The Trend graph displays the duration 
of the subsequent intervals. The x-axis 
lists the interval numbers. The y-axis 
displays the duration. 

• The Histogram graph displays the 
distribution of the intervals. The x-axis 
lists the duration (in ms, divided into 
bins of 8ms). The y-axis lists the 
number of intervals that falls in a 
particular bin.  

 

F, H, R 

Ft, Ht, Rt 

Fp, Hp, Rp 

file://skfnas01/../../../Concepts/Vector_cardiogram.htm
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HRV view (optional) 
This tab shows the heart rate variability.  
Additional information is available upon 
request. 
 
Note: HRV option not sold in the US. 

 
The view in the workspace can be used in for example a Word document. Right-click in the 
Workspace and select copy from the pop-up menu; paste the view in a document. 
 

4.3. Parameters  
The lower part of the workspace contains the Parameters pane. The Parameters pane contains 
global parameters that are determined from all leads. These parameters are: 
 

• Patient age and heart rate 
• P and PQ duration 
• QRS duration 
• QT, QTc and QTd duration 
• P, QRS and T axis 

 

4.4. QTc 
The QT interval in an ECG is a good indicator of the repolarization. However, the QT depends 
heavily on the heart rate. To make a useful measurement, the QT is usually corrected.  
 
Welch Allyn CardioPerfect offers three correction methods that can be used to derive the QTc 
parameter: 
 
• Bazett: 

6060
HRQT

HR

QT
RR

QTQTcB ===

 
 

• Fridericia: 

3

3
3 6060

HRQT

HR

QT
RR

QTQTcF ===  

 
• Hodges: 

)60(*75.1 −+= HRQTQTcH  
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To select the QTc correction method: 

1. In the File menu, click Settings. The Settings dialog box is displayed. 

2. Click ECG and click on the Viewing tab. 

3. Under QTc method, click the method that you want to use. 

4. Click OK to save your changes. 

 

4.5. QT dispersion (optional) 
 
Note: QT dispersion option not sold in the US. 
 
QT dispersion (QTd) is defined as the difference in duration between the longest QT interval and 
the shortest QT interval in any lead.  
 
There are several ways of calculating the QT dispersion. These ways depend on: 
 

• The reference point in the QRS complex from which the measurement should be started 
• Whether the marker that indicates the reference point should be local or global. A local 

marker is one that is taken for each lead, and therefore differs for each lead. A global 
marker is one that is used for all leads, and therefore is the same for all leads. 

• The number of leads that is used for calculation. 
 
The QTd duration is calculated and displayed in the Parameters area of the view. You can specify 
a number of options that affect the calculation of the QTd duration. 
 
To set QTd options: 

1. In the File menu, click Settings. The Settings window is displayed. 

2. Click ECG and click on the QT dispersion tab. 

3. In the QT dispersion tab, select which reference point you want to use, and whether it 
should be local or global. 

4. Select the number of leads you want to use, see section 8.1 for details. 

5. Click OK to save your changes. 

file://skfnas01/../../../Concepts/QT_dispersion.htm
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4.6. Working with views 
There are a number of things you can do in a view. They fall apart in the following groups of 
actions: 
 

Action Function  Available in 

Adjusting scales and 
magnitude of the view Zoom in and out  

4x3, 2x6, Averages, 
Rhythm, Old rhythm 
strip, Vector  

 Reset zoom 
4x3, 2x6, Averages, 
Rhythm, Old rhythm 
strip, Vector, R-R 

 Set chart speed 
4x3, 2x6, Averages, 
Rhythm, Old rhythm 
strip, Vector 

 Set sensitivity 
4x3, 2x6, Averages, 
Rhythm, Old rhythm 
strip, Vector 

View one single average or 
loop 

 
Enlarge 
 

Averages, Vector 

 Autosize Vector 

Improving signal quality Apply muscle noise filter 
 

4x3, 2x6, Averages, 
Rhythm, Vector 

 Apply AC filter 4x3, 2x6, Averages, 
Rhythm, Vector 

 Apply anti-aliasing 4x3, 2x6, Averages, 
Rhythm, Vector 

Studying the ECG Make measurements 4x3, 2x6, Averages, 
Rhythm, Vector 

 Compare ECGs Averages 

 Display markers Averages, Vector 
 
On the next pages, each action is described in detail. Most of these actions are also available 
from the right-click menu. 
 

4.7. Zoom in and out on an ECG 
If you want to get a closer look at the traces, you can adjust the size of the leads with by zooming 
in and out of the ECG.  
To see leads in more detail: 

• In the View menu, click Zoom in. 
 

To see a larger part of the ECG: 
• In the View menu, click Zoom out. 

 
To reset the zoom function and return to the standard lead size: 

• In the View menu, click Reset zoom. 
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4.8. Set chart speed and sensitivity 
Welch Allyn CardioPerfect offers a wide range of speed and sensitivity. You can adjust the scale 
of the ECG by adjusting the chart speed and the sensitivity.  
To set the chart speed: 

• In the View menu, point to Chart speed and select a value. The higher the chart speed, 
the more lead signal will be visible. 

 
To set the sensitivity: 

• In the View menu, point to Sensitivity and select a value. The lower the value, the lower 
the peaks in the lead signal will be.  

 

4.9. View one single complex or loop 
In the Averages view and the Vector view, you can view one single complex or loop. 
 

   
  
To view a single complex or loop: 

1. In the Action menu, click Enlarge. The first lead in an ECG (or the first loop in an VCG) 
is enlarged. With the autosize function, available from the right-click menu the selected 
loop will be shown as large as possible in the available space. 

2. To enlarge another lead or loop, select it from the drop down in the upper left corner of 
the workspace. 

3. To switch off the enlarge function, click Enlarge from the Action menu once more. 

4.10. Turn pacemaker on and off 
ECG traces can contain artificial pacemaker signal indicators. You can remove this artificial pacer 
indicator by disabling the "Show Pacer" selection. To learn how, see Customizing the Resting 
ECG software on page 40. 

4.11. Apply muscle noise filter 
Muscle noise in an ECG signal hides low amplitude signals that may be important for the 
interpretation of an ECG. You can remove this noise with a muscle noise filter.  
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To apply a muscle noise filter: 
• In the Action menu, click Muscle noise filter. 

 

4.12. Apply AC filter 
ECG traces can contain noise that is due to AC mains interference. This makes the traces harder 
to read. You can filter out noise by applying an AC filter. When you apply a filter, you do not 
change the actual ECG signal. You only change the way it is displayed on the monitor. The ECG 
signal always keeps its original form. 
 
To apply an AC filter while you view an ECG: 
 

• In the Action menu, click AC filter. 
 

4.13. Apply baseline filter 
ECG traces can contain some baseline wander caused by movement. You can reduce this 
wander of the baseline by applying a baseline filter. When you apply the baseline filter you only 
change the display of the traces. The actual signal remains unchanged. 
 
To apply a baseline filter while you view an ECG: 
 

• In the Action menu, click baseline filter. 
 
If accurate ST segment contours are required for ECGs, do not use the 0.5 Hz baseline wander 
filter. This filter suppresses baseline wander to the extent that it may alter the ST segment. 
Instead, configure your cardiograph to operate without the baseline wander filter. Regardless of 
the filter used, the rhythm characteristics of the ECG are accurately recorded and the filter 
settings do not affect the interpretation algorithm.  

4.14. Apply anti-aliasing 
When you view an ECG on a monitor, the signal can look ragged, especially when you zoom in on 
a complex. You can use anti-aliasing to make the signal look smoother. Anti-aliasing does not 
change the signal itself. It only affects how the signal is displayed on the monitor. 
 

        
 Before anti-aliasing    After anti-aliasing 
 
To apply anti-aliasing: 

• In the View menu, click Anti-aliasing.  
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4.15. Make measurements 
In each view that displays leads, complexes or vectors, you can make measurements between 
two points.  
To make a measurement between two points: 

1. Move the crosshair pointer to the starting point of your measurement. 

2. Double click on the starting point. Welch Allyn CardioPerfect inserts a mark. 

3. Move the crosshair pointer to the end point of your measurement. 

4. Double click on the end point. Welch Allyn CardioPerfect draws a line between the two 
points and displays the measured values. 

To clear all measurements: 
• In the Action menu, click Refresh. 

 

4.16. Compare ECGs 
If a patient has had several ECGs, Welch Allyn CardioPerfect can make a serial comparison of 
the average complexes of these ECGs. In such a comparison, the curves are superimposed in 
such a way that the starting points of the QRS complexes coincide. Serial comparison is only 
possible in the Averages tab. 
To compare ECGs: 

1. In the Tools menu, click comparison. The Comparison dialog box is displayed. This 
dialog box contains all other ECGs that have been recorded for this patient. 
 

 
 

2. In the Comparison dialog box, select one or more ECGs to which you want to compare 
your ECG. 

3. Click OK. The selected ECGs are now displayed. 
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4.17. Display markers 
Markers are convenient reference points that mark global points in an average complex or vector. 
You can use a marker as a starting point for your observations or measurements. You can only 
view markers in the Average and Vector tabs. 
 
Welch Allyn CardioPerfect inserts markers at the following points: 

• Start P wave 
• End P wave 
• Start QRS complex 
• End QRS complex 
• End T wave 

 
To display markers: 

• In the View menu, click Markers. The markers are displayed. 
 
Tips for displaying markers: 

• You can set the color of the markers in the ECG settings. 
• You can also use your right mouse menu for displaying markers. 
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5. Interpreting ECGs 
When you view an ECG, the interpretation is shown in the lower right corner of the workspace. If 
you have the optional MEANS software installed on your computer, this software makes an initial 
interpretation for you. If not, this is where you can enter your own interpretation. 
 

  
 

5.1. About MEANS and PEDMEANS interpretation software 
MEANS is short for Modular ECG Analysis System. PEDMEANS is short for Pediatric Modular 
ECG Analysis System. They are ECG interpretation programs developed by the University of 
Rotterdam in the Netherlands, and they can be used to interpret ECGs that were recorded with 
Welch Allyn CardioPerfect. 
 
MEANS and PEDMEANS use an algorithm that consists of signal processing, measurements, 
rhythm and contour classification. The adult algorithm is applicable to patient ages 18 and higher. 
The pediatric algorithm is applicable for ages 1 day through 17 years. 
 
MEANS and PEDMEANS interpretations consist of  

• A number of statements in different categories  
• Reasoning supporting the statement  
• A conclusion 
• An indication of the severity of the ECG 

 
Missing information 
The MEANS algorithm uses the gender and the age of a patient to make a reliable interpretation. 
If this information is not present in the patient card, the following assumptions are made: 

• The patient is male 
• The patient is 35 years old 

 
If these values are used, this is mentioned at the top of the interpretation. 
 

 
Caution  A computer-generated interpretation cannot replace sound medical reasoning 

by a trained professional. Therefore, a physician should always review the 
interpretation. 

 
 

Interpretation 
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5.2. Edit and confirm an interpretation 
You can edit an interpretation in the Interpretation editor. In this editor, you can enter your own 
texts. Alternatively, you can use the statement tree to select and enter common interpretation 
statements. Until confirmed, the test will be labeled as ‘Unconfirmed Interpretation’. 
 

  

To edit and confirm an interpretation manually: 

1. In the Tools menu, click Interpretation. The Interpretation editor is displayed. 

2. In the Interpretation display, at the pointer, start typing. 

3. Click the Confirm button to save your comments and to return to the ECG. 

 

To edit and confirm an interpretation with the statement tree: 

1. In the Tools menu, click Interpretation. The Interpretation editor is displayed. 

2. From the statement tree, click on one of the categories to display all possible statements 
for that category. 

3. From a category, click on the statement that you want to include in the interpretation. The 
statement is added.  

4. To delete a statement from the interpretation, select the statement text and press 
BACKSPACE to delete it. 

5. Click the Confirm button to save your comments and to return to the ECG. 

 

Tips for editing and confirming an interpretation: 
• You can automatically insert the current date and time by clicking the Date/time button.  
• You can clear the interpretation editor by clicking the Clear button. 
• When you return to the ECG after confirming an interpretation, the interpretation header 

shows the date and time of confirmation and the name of the person that confirmed it. 
• The statement tree can be changed. Please consult your system administrator or local 

Interpretation 
display 

Statement tree 
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dealer for new or changed statements. 
 

5.3. View interpretation history 
When you change something in an interpretation, Welch Allyn CardioPerfect does not change the 
original interpretation but creates a new one. This way, you never lose any information. A copy of 
all interpretations is kept in the interpretation history. 
 

 
 

To view the interpretation history: 

1. In the Tools menu, click History. The Interpretation history window is displayed. The 
left-hand pane displays the interpretations sorted by date. The right-hand pane shows 
the content of each interpretation, plus the interpretation date, time and editor. 

2. Click on a date to view an interpretation. 

5.4. Reanalyze an ECG 
When you have overwritten a MEANS interpretation with a manual interpretation, you can always 
get the MEANS interpretation back. To do this, you need to reanalyze the ECG. 
To reanalyze an ECG: 

• In the Tools menu, click Reanalyze. The original MEANS interpretation is placed back in 
the interpretation window. 

 
 

Interpretation dates Interpretation  

Date and editor 
of the 
interpretation 
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6. Printing ECGs 

6.1. Print an ECG 
You can make a printout of each view in the ECG at any time between recording and 
interpretation. There are two ways of manually printing an ECG: 
 

• One view: Welch Allyn CardioPerfect prints one view in the way it is displayed on the 
monitor. 

• Selected formats: Welch Allyn CardioPerfect prints a number of views simultaneously. 
 

Print formats 
The resting ECG Module can print the following reports: 
 

• 12 averages + 6 rhythm leads 
• 2x6, all pages 
• 2x6, two pages 50 mm/s 
• 2x6 
• 4x3, 25 mm/s 
• 4x3, 50 mm/s 
• 4x3 5 mm/mV 
• 4x3 20 mm/mV 
• Averages 
• Large averaged complex 
• Measurements 
• OldRhythm 
• Rhythm 
• R-R 
• Vectors 
• HRV 

 
Each report contains the view and a header that displays additional information.  
 
Please refer to the Workstation manual for further information on printing ECGs. 

6.2. Automatically print an ECG 
Welch Allyn CardioPerfect can automatically print an ECG directly after recording and after 
confirming the interpretation. To automatically print an ECG, you need to enable automatic 
printing and select the ECG formats to be printed. 
 
To enable automatic printing: 

1. In the File menu, click Settings. The Settings dialog box is displayed. 

2. Click ECG and click on the Printing tab. 

3. In the Printing tab, click Print after recording and/or Print after interpretation confirmed. 

4. Click OK to confirm. 
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7. Maintaining the Recorder 
To keep your Welch Allyn AM12 Recorder in good working condition, do not expose the Recorder 
to temperatures lower than -20° C or higher than 60° C, at a maximum non-condensing humidity 
of 95%. 
 

Warning  
 
Keep the AM12 ECG Recorder, reusable electrodes, and the patient 
cable clean. Patient contact with contaminated equipment can 
spread infection. 
 
The patient cables should be cleaned after each use and disinfected 
as needed. 

Caution  
 
Never immerse the AM12 ECG Recorder or the patient cable in 
liquid. Never autoclave or steam clean the AM12 ECG Recorder or 
the patient cable. Never pour alcohol directly on the AM12 ECG 
Recorder or the patient cable, and never soak any components in 
alcohol. If any liquid enters the AM12 ECG Recorder, remove the 
AM12 ECG Recorder from service, and have it inspected by a 
qualified service person before using it again. 
 

 

7.1. Clean the AM12 ECG Recorder 
 
Unless the AM12 ECG Recorder (the device itself rather than the cables and electrodes) comes 
in direct contact with a patient, it is acceptable to clean the device on a routine basis according to 
your facility's protocols and standards or local regulations. Patient contact with the device might 
require immediate cleaning. 
The following agents are compatible with the AM12 ECG Recorder: 
Clorox Healthcare® Bleach Germicidal Wipes (use according to instructions on product label), or  
a soft, lint-free cloth with a solution of Sodium Hypochlorite (10% household bleach and water 
solution) minimum 1:500 dilution (minimum 100 ppm free chlorine) and maximum 1:10 dilution as 
recommended by the APIC Guidelines for Selection and Use of Disinfectants 
 

Caution  
 
When cleaning the device, avoid using cloths or solutions that 
include quaternary ammonium compounds (ammonium chlorides) or 
glutaraldehyde-based disinfectants. 
 

 

7.2. Cleaning the Patient cables and PC interface cables 
 
When you use electrodes that need electrode gel, make sure that the cables and the 
non-disposable electrodes are cleaned regularly. Otherwise, the gel may build up on the wires. 
 
Clean the cables 

1. Slightly dampen a soft, clean cloth with lukewarm, soapy water or a neutral cleaner and 



 
CardioPerfect Workstation 

Resting ECG Module - User Manual 
 

DIR 80012333 Ver. G   37 / 56 
 

clean the patient cable and PC USB interface cable. 
2. Dry all cables with a clean, soft cloth or paper towel. 
3. Wait at least 10 minutes before powering on the AM12 ECG Recorder again. 

 
Disinfect the cables 
For disinfecting the exterior surfaces of the cables and lead wires, wipe the exterior using:  
Clorox Healthcare® Bleach Germicidal Wipes (use according to instructions on product label), or  
a soft, lint-free cloth with a solution of Sodium Hypochlorite (10% household bleach and water 
solution) minimum 1:500 dilution (minimum 100 ppm free chlorine) and maximum 1:10 dilution as 
recommended by the APIC Guidelines for Selection and Use of Disinfectants  
 

Caution  
 
Do not use these agents for routine cleaning of the cables. Alcohol 
can cause the plastic to become brittle and may cause the cable to 
fail prematurely. 
 

 
Inspecting the equipment 
Perform the following inspections daily: 

• Check for cracks or breaks in the PC USB interface cable, the patient cable, the patient 
electrodes, and the AM12 ECG Recorder. 

• Check for bent or missing pins on all cables. 
• Check all cable and cord connections; reseat if any connectors are loose. 

 
 

8. Acquisition Module 
AM12 with Lead Wires  
 

 
 
 

 
The AM12 is available for a traditional wired connection with direct USB connection and 40,000 
Hz ECG acquisition. The 12-Lead ECG button can be used to acquire a 12-lead ECG at the 
patient’s side. 
 
 
 
 

Replaceable 
Lead Wires 

LED 
Indicators 

12-Lead ECG button 

Rhythm button 

USB cable 
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AM12 Specifications 

FEATURE SPECIFICATION* 
Instrument Type 12-lead USB-connected ECG acquisition

module

Input Channels 12-lead signal acquisition and transmission

ECG Leads Transmitted I, II, III, aVR, aVL, aVF, V1, V2, V3, V4, V5, and 
V6 

Lead Set RA, LA, RL, LL, V1, V2, V3, V4, V5, and V6 (R, 
L, N, F, C1, C2, C3, C4, C5, and C6) with 
detachable lead wires 

Sampling Rate 40,000 samples/second/channel acquisition; 
1,000 samples/second/channel transmitted for 
analysis 

Resolution 1.875 μV/LSB 

User Interface Two-button operation: ECG and Rhythm; 
Rhythm button captures Rhythm ECG 

Defibrillator Protection Complies with AAMI standards and IEC 
60601-2-25 

Recovery time after defibrillation 100% gain accuracy after 5 seconds 
Operation Continuous 
Special Functions LED indication of power status, operating mode, 

and lead fail 

Device Classification Type CF, USB powered 

Weight 16.2 oz (460 g) including lead wires 

Dimensions 4.45 x 4.25 x 1.1” (11.3 x 10.8 x 2.79 cm) 

Storage Temperature -20° to +50° C (-4° to 122° F)

Transport Temperature -20° to +49° C (-4° to 120° F)

Relative Humidity 15 to 95% (non-condensing) 

Altitude Operate normally and prolonged storage up to 
3000m 

Medical Device Directive  
The AM12 complies with the Medical Device Directive 93/42/EEC and carries the CE mark 
accordingly.  
Declaration of Conformity available upon request. 
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*Specifications subject to change without notice 
 

8.1. Lead Fail  
In the software, lead failure is represented as a square wave being presented on the lead that has 
failed. On the acquisition module, lead fail is indicated using LEDs located on the front of the 
AM12. A yellow LED indicates a lead fail condition is present in one or more leads. A solid green 
LED indicates proper lead connection in all leads.  
 

8.2. ECG Collection Using the Acquisition Module  
 
ECG acquisition can be performed at the AM12 acquisition module. Select the 12-Lead ECG 
button on the AM12™ to capture 10 seconds of ECG (see also §2.9). For a rhythm recording, 
press the Rhythm button; press again to stop (see also §2.10).  
 

8.3. Connecting the Acquisition Module  
 
The AM12 connects to a USB port on the PC for signal acquisition. The CardioPerfect 
Workstation software will automatically detect the AM12 once it’s connected to the USB port.  
 

8.4. Accessories 
 
AM12 Accessories 

Part Number Description 
9293-046-62 RPLCE LD SET WAM/AM12 LIMBS BANA AHA GRY 
9293-046-63 RPLCE LD SET WAM/AM12 LIMBS BANA IEC GRY 
9293-046-64 RPLCE LD SET WAM/AM12 V1-V3 BANA AHA GRY 
9293-046-65 RPLCE LD SET WAM/AM12 C1-C3 BANA IEC GRY 
9293-046-66 RPLCE LD SET WAM/AM12 V4-V6 BANA AHA GRY 
9293-046-67 RPLCE LD SET WAM/AM12 C4-C6 BANA IEC GRY 
9293-047-62 RPLCE LD SET WAM/AM12 LIMBS CLIP AHA GRY 
9293-047-63 RPLCE LD SET WAM/AM12 LIMBS CLIP IEC GRY 
9293-047-64 RPLCE LD SET WAM/AM12 V1-V3 CLIP AHA GRY 
9293-047-65 RPLCE LD SET WAM/AM12 C1-C3 CLIP IEC GRY 
9293-047-66 RPLCE LD SET WAM/AM12 V4-V6 CLIP AHA GRY 
9293-047-67 RPLCE LD SET WAM/AM12 C4-C6 CLIP IEC GRY 
 
Electrodes 

Part Number Description 
108071 Tab Electrode Case/5000 
108070 Snap Electrode Case/300 
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9. Customizing the Resting ECG software 
You can customize the Welch Allyn CardioPerfect software to your own preferences. The 
features that you can customize are located in the ECG settings (File > Settings).  
 

9.1. General tab 
In the General tab, you can configure a number of common options that are used by Welch Allyn 
CardioPerfect. 
 
The General tab contains the following options: 

Default chart speed From this list, you can select the default monitoring chart speed. 
Possible values are 5, 10, 12.5, 25, 50,100 mm/sec. 

Default sensitivity From this list, you can select the default monitoring sensitivity. 
Possible values are 5, 10 or 20 mm/mV. 

Extremity lead order With this option you can choose from two different lead orders: 
Standard (aVL, I, -aVR, II, aVF, III) and Cabrera (I, II, III, aVR, 
aVL, aVF). 

Maximum recording length The maximum number of seconds for a rhythm recording. 

Anti-alias monitor If this option is selected, your monitor is anti-aliased, so that the 
curves of the ECG signal appear smoother. 

Show new ECG dialog If this option is selected, the New ECG dialog box is displayed 
when you start a new ECG. Otherwise, you are taken straight to 
the Real-time monitor to start recording. See page 14 for more 
details. 

Ask for lead set on pediatric patients 

If this option is selected and you select a pediatric patient, Welch 
Allyn CardioPerfect will ask you whether you want to use a 
pediatric lead set.  
 

Show Pacer By disabling this setting, you can remove artificial pacemaker 
signal indicators. For example, see Pacemaker pulse detection on 
page 17. 

Amplitude unit The unit in which the amplitude is displayed. This can be either 
micro volts or millimeters. 

Muscle filter frequency This setting will affect the high cutoff frequency that is used by the 
muscle filter. 
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9.2. Viewing tab 
In the Viewing tab you can configure the settings that determine how the ECGs will be displayed 
on the screen. 
 
The Viewing tab contains the following options: 

QTc method (Bazett, 
Hodges, Fridericia) 

With this option you can set the method that should be used to 
correct the measured QT. 

AC filter mode With this option you can set the mode of the AC mains filter.  

Appearance Here, you can specify individual colors for the background, grid 
lines, grid dots, trace, begin and end of the QRS complex, the 
markers, the T wave and the font that is used in the ECG. 

Color schemes This list lets you choose from a number of predefined color 
formats. 

Grid style From this list you can select the style of the grid in which the ECG 
is displayed. You can either leave out the grid, use lines to 
represent the grid, or display a full grid. 

9.3. Printing tab 
In the Printing tab, you can configure automatic printing and selected formats. The Printing tab 
contains the following options: 

Default report templates From this list of templates, you can select the formats that are 
printed when automatic printing is enabled. These formats are 
also printed when you click Print selected formats in the ECG 
window. 

Grid From this list, you can select the grid style in which the selected 
formats should be printed. 

Print after recording If this option is selected, the ECG is automatically printed when 
the recording has finished. Welch Allyn CardioPerfect prints the 
formats that you selected in the Default report templates area. 

Print after interpretation is confirmed  
If this option is selected, the ECG is automatically printed when 
the interpretation of the ECG has been confirmed. Welch Allyn 
CardioPerfect prints the formats that you selected in the Default 
report templates area. 

Print calibration pulse If this option is selected, the calibration pulse will be printed. 
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9.4. QT dispersion tab  
The QT dispersion tab is only visible when you have purchased the QT dispersion software. Use 
the QT dispersion tab to set your preferences for the calculation of the QT dispersion. 
 
Note: QT dispersion option not sold in the US. 
 
The QT dispersion tab contains the following options: 

Reference point In the Reference point area, you can specify from which reference 
point in the QRS complex the measurement should be started, 
and whether that reference point should be the same for all leads 
(global), or whether it should be set for each lead (local). 

Leads In the Leads area, you can specify the number of leads you want 
to use in calculating the QT dispersion. 

Reference point 

If you select… Then… 

Local Q Reference point is local Q point. 

Local J Reference point is local J point. 
Global Q Reference point is global Q point. 
Global J Reference point is global J point. 
 
Leads 

If you select... The leads that are used are... 
6  6 precordial leads 
8  The shortest peripheral lead  

The mean of all other peripheral leads 
10  6 precordial leads 

All peripheral leads except the shortest and the longest one. 
12  All 12 leads. 
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9.5. Recorder Tab 
In the Recorder tab, you can configure your Welch Allyn AM12  Acquisition Module. You can only 
access this tab when you have administrator rights or when the software security is switched off.  

The Recorder tab contains the following options: 

Model Use the AM12. 

Port The communication port of the PC to which the recorder is 
connected. This is typically the USB port.  

 When operating in a thin-client environment, the application 
displays an additional option, called PerfectLink™. This option 
allows the use of the AM12 Recorder with a USB cable in thin 
client environments.  

AC filter (Hz) The frequency that is filtered by the AC mains filter. This can be 
either 50 or 60 Hz. 

9.6. Customize ecg.txt 
You can customize the statements that are used in the Comment editor according to your own 
preferences. Please refer to the Workstation manual for further instructions. 
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10. Troubleshooting 
In this chapter, some known problems and possible solutions are described.  
 
 

Some buttons or menu entries are inactive 
• This is probably caused by the fact that your user role does not allow you to perform the 

actions of those buttons or menu entries.  
 

Test recovery 
To recover a test after the database connection has been lost: 
 
If during the test the connection to the database is lost, for example because of a loose network 
cable, the test will be saved in a file called “Emergency saved resting ECG #x.MDW” (x stands for 
a number, which is automatically generated) in the database folder named in the error message. 
After the database connection has been restored, this file can be imported into the database by 
using the import function in the Workstation (File – Import, browse to the folder and select the 
correct file). 
 

Technical Support 
If you have a technical question that you cannot answer with the provided tools, please contact 
our Installation & Support department or contact your local distributor. 
 
When you contact the Installation & Support department via phone, e-mail or fax, please provide 
the following information: 

• Your name, company name, address, phone number, fax number and e-mail address. 
• Product serial number. 
• Exact product name and version number. 
• Type of operating system. 
• Type of installation (network or standalone). 
• A copy of the Technical Support Form. 
• Complete description of the problem and the steps to reproduce it. If applicable we would 

also like to have the exact error message. 
 
To print the Technical support form: 

1. In the Help menu, click Information.  
2. Click on the Registration tab. 
3. Click on the Support... button. The Welch Allyn CardioPerfect support form is now 

printed and saved as file MDW.txt in the MDW installation directory. You can fax the 
printout or e-mail the file. 
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11. Function keys 
The Welch Allyn CardioPerfect module is, just like all Windows applications, designed for working 
with the mouse. However, there might be situations in which working with the keyboard can be 
quicker. Therefore, a number of functions within the Welch Allyn CardioPerfect module can also 
be selected directly using the keyboard. Here is a list of all available keyboard shortcuts in this 
module; for a more general function key description please refer to the Workstation manual: 
 
 
Viewing 
Key Function 
[SHIFT]+[CTRL]+[E] Starts a new Resting ECG recording. 
[CTRL]+[I] Opens the Interpretation window 
[CTRL]+[H] Opens the Interpretation History 
[CTRL]+[DOWN] Zooms out. 
[CTRL]+[UP] Zooms in. 
[CTRL]+[E] Enlarge average complex or vector loop. 
[CTRL]+[M] Activates the markers (only active in the ‘Averages’ and ‘Vector’ tab). 
[CTRL]+[R] Activates the refresh functionality, which clears all user made 

measurements. 
 
Real time monitor 
Key Function 
F2 Start/stop test 
[Esc] Exit the recording.  
F12 Starts a long recording (In Real Time Monitor). 
[INS] Inserts an event in the recording (Real-time monitor only) 
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12. Before installing the Resting ECG software 

In this chapter, you will find information about the structure of the Welch Allyn CardioPerfect 
resting ECG software. 
 

12.1. Structure 
The workstation consists of two elements:  

• Hardware: the recorder and the interface to the computer. 
• Software: the Resting ECG module that runs in the Welch Allyn CardioPerfect 

Workstation. 
 
The recorder must be connected to the computer that runs the module. 
 

Software 
The Resting ECG module is automatically installed with Welch Allyn CardioPerfect Workstation. 
For instructions on how to install and configure Welch Allyn CardioPerfect Workstation, please 
refer to the Installation manual. 
 

Hardware 
The AM12uses a USB cable to communicate with the computer. 
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13. Installing the Resting ECG Module 
Before you can start recording ECGs, you need to:  

• Install the hardware 
• Install the drivers 
• Configure the software 

 

13.1. Connecting the   AM12 
 

 
Please run the software installation prior to inserting the USB-Interface into a USB socket 
of your computer. 
To set up your computer for use of the USB Interface: 

1. Connect the AM12 to the USB port of the computer. 
 
 

To configure Welch Allyn CardioPerfect Workstation: 

1. Start Welch Allyn CardioPerfect Workstation and log in as Administrator. 
2. In the File menu, click Settings, click ECG, and click on the Recorder tab. 
3. In the Model list, select AM12. 
4. From the Port list, select USB (This is the default setting after a new installation) 
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14. Safety and precautions  

Conventions  

WARNING - 
Warning statements describe conditions or actions that can result 
in personal injury or loss of life. 
 

CAUTION - 
Caution statements describe conditions or actions that can result 
in damage to the equipment or software. 
 

  
  
NOTE - Notes contain additional information on cardiograph usage. 

 
 

 

 
 

Attention (Caution, Warning, Danger, Important, Note, Refer to 
Accompanying Documentation) 

 
Caution 

 Warning 

 

 
 
 

Ingress Protection (ordinary) 

 

 
 

Serial Number 

 

 
 

Reference Number 

 
 

Defibrillation-Proof Type CF applied part 

 

 

Manufacture Date 
YYYY-MM-DD 



 
CardioPerfect Workstation 

Resting ECG Module - User Manual 
 

DIR 80012333 Ver. G   49 / 56 
 

 

 
 

CE Mark for Class Is, Im, IIa, IIb & III 

 

 
 

Temperature Range 
 

 Reorder Number 

 

Dispose of this product and its accessories according to local 
regulations. Do not dispose of as unsorted municipal waste. For 
more specific disposal or compliance information, go to 
www.welchallyn.com/weee or contact Welch Allyn Technical 
Support at www.welchallyn.com/about/company/locations.htm.  

 

 

Consult operating instructions/directions for use (DFU). A copy 
of the DFU is available on this website. A printed copy of the 
DFU can be ordered from Welch Allyn for delivery within 7 
calendar days. 

 Global Trade Item Number 

 
Electromagnetic Compatibility 
When using the AM12 cardiograph, electromagnetic compatibility with surrounding devices 
should be considered and evaluated. The AM12 cardiograph complies with IEC 60601-1-2 limits 
for EMC. 
 

General Safety and Precautions tips 
 

Caution  
Radio Frequency (RF) interference between the cardiograph and any 
existing RF transmitting or receiving equipment at the installation site, 
including electrosurgical equipment, in close proximity to the 
cardiograph should be evaluated before the equipment is operated as 
they may seriously degrade performance. 
 
The AM12 Cardiograph is susceptible to interference from RF energy 
sources (lowered RF immunity) which exceed the IEC 60601-1-2 limits, 
such as power line bursts, other medical devices, cellular products, 
information technology equipment and radio/television transmission. 
 
To reduce EMC interference the cardiograph shall be separated from 
the emitting source as much as possible. If assistance is needed, call 
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your local Welch Allyn service representative. 
 
Artifact on the ECG caused by electromagnetic interference should be 
evaluated by a physician or physician authorized personnel to 
determine if it will negatively impact patient diagnosis or treatment. 
 
Like all electronic devices, this cardiograph is susceptible to 
electrostatic discharge (ESD). Electrostatic discharge typically occurs 
when electrostatic energy is transferred to the patient, the electrodes, or 
the cardiograph. ESD may result in ECG artifact that may appear as 
narrow spikes on the cardiograph display or on the printed report. When 
ESD occurs, the cardiograph’s ECG interpretation may be inconsistent 
with the physician’s interpretation.  
 

Welch Allyn assumes no liability for failures resulting from RF 
interference between Welch Allyn medical electronics and any radio 
frequency generating equipment when these levels exceed those 
established by applicable standards.  

 
 
 
Patient and Operational Safety 
The cardiograph isolates all connections to the patient from electrical ground and all other 
conductive circuits in the cardiograph. This reduces the possibility of hazardous currents passing 
from the cardiograph through the patient’s heart to ground. To ensure the patient’s safety and 
your own please observe the following: 
 
Any system components (e.g. treadmill, personal computer, ergo meter) that require to be 
connected to an outlet socket shall use only grounded power cords (three-wire power cords with 
grounded plugs). Also make sure the outlet accepts the plug and is grounded. Never adapt a 
grounded plug to fit an ungrounded outlet by removing the ground prong or ground clip.  
 
Multiple portable outlet sockets shall not be placed on the floor. Multiple portable outlet sockets or 
extension cord shall not be connected to the system. Do not connect items which are not part of 
the system. The use of multiple (non-) medical electrical equipment connected to the same 
patient may pose a safety hazard due to the summation of leakage currents from each 
instrument. Any combination of (non-) medical electrical equipment should be evaluated by local 
safety personnel before put into service. Multiple portable outlet sockets use without an isolation 
transformer is disapproved unless casual access for additional equipment is impeded or 
prevented. 
 

Patient cable and Interface cable 
 

Caution  
The patient cable supplied with the AM12 cardiograph is an integral part 
of the cardiograph’s safety features. Using any other patient cable may 
compromise defibrillation protection as well as cardiograph 
performance. The patient cable should be routed away from power 
cords and any other electrical equipment. Failure to do so can result in 
AC power line frequency interference on the ECG trace.  
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Warning  Do not touch the patient, patient cable, PC interface cable  or 
cardiograph during defibrillation. Death or injury may occur from the 
electrical shock delivered by the defibrillator. It is recommended to 
check the patient cable and PC interface cable  for damage prior to the 
use of the system. If damage exists do not use the cable, contact your 
local Welch Allyn Sales Office or your authorized Welch Allyn dealer or 
distributor to have the cable replaced. 

 

15. Electromagnetic Compatibility (EMC) 
Electromagnetic Compatibility  
 
Electromagnetic compatibility with surrounding devices should be assessed when using 
the device. 
 
An electronic device can either generate or receive electromagnetic interference. Testing 
for electromagnetic compatibility (EMC) has been performed on the device according to 
the international standard for EMC for medical devices (IEC 60601-1-2). This IEC 
standard has been adopted in Europe as the European Norm (EN 60601-1-2). 
 
The device should not be used adjacent to, or stacked on top of other equipment. If the 
device must be used adjacent to or stacked on top of other equipment, verify that the 
device operates in an acceptable manner in the configuration in which it will be used. 
 
Fixed, portable, and mobile radio frequency communications equipment can affect the 
performance of medical equipment. See the appropriate EMC table for recommended 
separation distances between the radio equipment and the device. 
 
The use of accessories, transducers, and cables other than those specified by Welch 
Allyn may result in increased emissions or decreased immunity of the equipment. 
 
Emissions and immunity information 

 
Guidance and Manufacturer’s Declaration: Electromagnetic Emissions 

 
The equipment is intended for use in the electromagnetic environment specified in the table below. The customer or the 
user of the equipment should ensure that it is used in such an environment. 

Emissions test Compliance Electromagnetic environment - guidance 
RF emissions 
CISPR 11 

Group 1 The equipment uses RF energy only for its internal function. 
Therefore, its RF emissions are very low and not likely to 
cause any interference in nearby electronic equipment. 

RF emissions 
CISPR 11 
 
 

Class A 
 
 
 
 

The equipment is suitable for use in all establishments other 
than domestic and those directly connected to the public 
low-voltage power supply network that supplies buildings 
used for domestic purposes. 

Harmonic emissions Complies 
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IEC 61000-3-2 
Voltage fluctuations/ 
flicker emissions 
IEC 61000-3-3 

Complies 

 
 

Guidance and Manufacturer’s Declaration: Electromagnetic Immunity 
 

The equipment is intended for use in the electromagnetic environment specified in the table below. The customer or the 
user of the equipment should ensure that it is used in such an environment. 

Emissions test Compliance  Compliance level Electromagnetic environment - guidance 
Electrostatic 
discharge 
(ESD) 
IEC 61000-4-2 

±6 kV contact 
± 8 kV air 

± 6 kV contact 
± 8 kV air 

Floors should be wood, concrete or ceramic 
tile. If floors are covered with synthetic 
material, the relative humidity should be at 
least 30%. 

Electrical fast 
transient/burst 
IEC 61000-4-4 

±2 kV for power 
supply 
lines 
±1 kV for 
input/output 
lines 

±2 kV for power supply 
lines 
±1 kV for input/output 
lines 

 

Surge 
IEC 61000-4-5 

± 1 kV 
differential 
mode 
± 2 kV common 
mode 

± 1 kV differential 
mode 
± 2 kV common mode 

 

Voltage dips, short 
interruptions and 
voltage variations on 
power supply input 
lines 
IEC 61000-4-11 

<5% UT 
(>95% dip in UT) 
for 
0.5 cycle 
40% UT 
(60% dip in UT) 
for 5 
cycles 

<5% UT 
(>95% dip in UT) for 
0.5 cycle 
40% UT 
(60% dip in UT) for 5 
cycles 

 

Power frequency(50/ 
60Hz)magnetic field 

3 A/m 3 A/m Power frequency magnetic fields should be at 
levels characteristic of a typical location in a 
typical commercial or hospital environment. 

 

Note: UT is the AC Mains voltage prior to application of the test level. 

 
 

Guidance and Manufacturer’s Declaration: Electromagnetic Immunity 
 

The equipment is intended for use in the electromagnetic environment specified in the table below. The customer or the 
user of the equipment should ensure that it is used in such an environment. 
 
 

Emissions test IEC 60601 test level Compliance level Electromagnetic environment - guidance 
Conducted RF 
IEC 61000-4-6 

3 Vrms 
150 kHz to 
80 MHz 

3 Vrms 
150 kHz to 
80 MHz 

Portable and mobile RF communications 
equipment should be used no closer to any part 
of the equipment, including cables, than the 
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recommended separation distance calculated 
from the equation applicable to the frequency 
of the transmitter. 

Radiated RF 
IEC 61000-4-3 

3 V/m 80 MHz to 2.5 
GHz 

3 V/m 80 MHz to 2.5 
GHz 

Recommended separation distance 

 

 80 MHz to 800 MHz 

 800 MHz to 2.5 GHz 
 
of the transmitter in watts (W) according to the 
transmitter manufacturer and d is the 
recommended separation distance in meters 
(m). 
 
Field strengths from fixed RF transmitters, as 
determined by an electromagnetic site surveya, 
should be less than the compliance level in 
each frequency rangeb. 
 
Interference may occur in the vicinity of 
equipment marked with the following symbol: 

 
aField strengths from fixed transmitters, such as base stations for radio (cellular/cordless) telephones and land mobile 
radios, amateur radios, AM and FM radio broadcast, and TV broadcast cannot be predicted theoretically with accuracy. 
To assess the electromagnetic environment due to fixed RF transmitters, an electromagnetic site survey should be 
considered. If the measured field strength in the location in which the equipment is used exceeds the applicable RF 
compliance level above, the equipment should be observed to verify normal operation. If abnormal performance is 
observed, additional measures may be necessary, such as reorienting or relocating the equipment. 
 
bOver the frequency range 150 kHz to 80 MHz, field strengths should be less than [3] V/m. 
 
Recommended separation distances between portable and mobile RF communications 
equipment and the equipment 
The equipment is intended for use in the electromagnetic environment in which radiated RF disturbances are controlled. 
The customer or the user of the equipment can help to prevent electromagnetic interference by maintaining a minimum 
distance between portable and mobile RF communications equipment (transmitters) and the equipment as 
recommended in the table below, according to the maximum output power of the communications equipment. 
Rated max. output 
power of transmitter 
(W) 

Separation distance according to frequency of transmitter (m) 

  150 KHz to 800 MHz 800 MHz to 2.5 GHz 
  

 
0.01  0.1m 0.2m 
0.1  0.4m 0.7m 
1  1.2m 2.3m 
10  4.0m 7.0m 
100  12.0m 23.0m 
For transmitters rated at a maximum output power not listed above, the recommended separation distance d in meters 
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(m) can be estimated using the equation applicable to the frequency of the transmitter, where P is the maximum output 
power rating of the transmitter in watts (W) according to the transmitter manufacturer. 
 
Note 1: At 800 MHz, the separation distance for the higher frequency range applies. 
 
Note 2: These guidelines may not apply in all situations. Electromagnetic propagation is affected by absorption and 
reflection from structures, objects, and people. 
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